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Terms and Conditions of License for use of gratuitous software

Thank you for purchasing US Digital products.

By downloading or using US Digital software, you agree to the terms and conditions below and as further
detailed on our website at https://www.usdigital.com/company/legal. If you do not agree with such terms
and conditions, do not use the software. You may promptly return the software and other items that are
part of this product in their original package with your sales receipt to your point of purchase for a full
refund, or if you have downloaded this software from a US Digital web site, then you must stop using the
software and destroy any copies of the software in your possession or control. These terms and
conditions which accompany the original or new versions of the software and patches, point releases,
maintenance releases, updates, enhancements, or upgrades thereto upon installation or download, are
applicable.

Permission to use, copy, modify and distribute this software without fee is hereby granted. US Digital
makes no warranty or representations about the suitability of the software for any purpose. It is provided
"AS IS" without any express or implied warranty, including the implied warranties of merchantability,
fithess for a particular purpose and non-infringement. US Digital shall not be liable for any direct, indirect,
special, or consequential damages resulting from the loss of use, data or projects, whether in an action of
contract or tort, arising out of or in connection with the use or performance of this software. Your use of
the software is entirely at your own risk. In connection with the software, you agree to comply with all
export laws and restrictions and regulations of the Department of Commerce, the United States
Department of Treasury Office of Foreign Assets Control ("OFAC"), or other United States or foreign
agency or authority, and you agree not to export, or allow the export or re-export of the software in
violation of any such restrictions, laws, or regulations. Downloading or using US Digital software is implicit
acceptance of these terms and conditions and as further detailed at
https://www.usdigital.com/company/legal.

Purpose:

The US Digital COMTool application is designed to assist debugging of serial
communication between a host PC and US Digital devices that provide a serial
interface. This document describes how to install the COMTool application and use all
available features.
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Installation Instructions:

Download the COMTool application from US Digital website
https://www.usdigital.com/support/resources/downloads/software/comtool-software/ and run the
COMTool Installation.

The installation program will install the COMTool application with a preloaded list of
commonly used commands for US Digital serial devices. Drivers for a specific US
Digital device can be downloaded from US Digital’s device specific software page.

The following is a list of some of the US Digital serial devices supported by the
COMTool application: A2, QSB, T7 (Modbus and Standard), and MD3.

The COMTool setup program displays the following sequence of screen shots. Typically
the Next button is clicked on each screen to install the default COMTool configuration.

ig- US Digital COMTool

Welcome to the US Digital COMTool Setup Wizard LA

The inztaller will guide vou through the steps required toinstall 15 Digital COMT ool on pour
computer.

WARMIMNG: This computer program iz protected by copyright law and intemational reaties.
|Unauthonzed duplication or diztibution of this program, or any portion of it, may result in severe civil
or criminal penaltiez, and will be prozecuted to the maximum extent poszible under the law.

Click the Next button.
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il US Digital COMTool

Select Installation Folder LA

The ingtaller will ingtall IS Digital COMT aal ta the following falder.

T inztall in this folder, chck "Mext". Ta nstall to a different falder, enter it below or click "'Browse'".

Enlder:
C:hPrograrm Files (861505 DigitalsUS Digital COMT aal Browse. .

[hzk, Cozt..

Install LIS Digital COMTool for yourself, or for anyone who uses this computer:

(®) Evemnone
0 Just me

¢ Back Canicel

Click the Next button unless the default program destination folder needs to be
changed.

Local: 360-260-2468 e Toll-free: 800-736-0194 e Support: 360-397-9999 e Fax: 360-260-2469
Email: info@usdigital.com e Website: www.usdigital.com
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il US Digital COMTool

Confirm Installation LA

The ingtaller iz ready ta inztall 1S Digital COMT ool an your campter.

Chck "Mest" ta start the installabion.

¢ Back Canicel

Click the Next button.
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il US Digital COMTool

Installation Complete LA

115 Digital COMT ool haz been successfully installed.

Click "Cloze" to exit.

Please use Windows Update to check for any critical updates ta the MET Frameswark.

¢ Back Canicel

Click the Close button.
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Using COMTool:
Locate and start the COMTool program.

Click on the Windows Start Icon. Locate and click the US DigitaN\COMTool menu item
from the Windows Start menu.

Select a COM Port

. COMTool Version 3.5 - C:\ProgramData‘\US Digital COMTool\COMToaol

File  Refresh Ports  Help

Product Communication Settings
Serial Port Product Baud Rate

Commands Scr

Select the COM port that the target device uses. If there is more than one COM port
listed, then the target device COM port can be identified by observing the COM Port list
while the device is unplugged and then re-plugged. The device will disappear when
unplugged and then re-appear once plugged back in. If it does not appear, clicking the
“‘Refresh Ports” menu item will search for connected devices.

Select a product

5 - C\ProgramDatatUs Digitah COM

Help

ication Setfings
Serial Port Product

com3 ~ ¥ v

Generic
- T7 Modbus

T7 Standard
Q5B
MD 3
Senal Number

Selecting a predefined product causes the COM port settings to automatically be
selected for Baud Rate, Parity, Data Bits, Stop Bit, and Hand Shaking.

. W= Us Digital ® 1400 NE 136" Avenue e Vancouver, Washington e 98684 e USA e
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. COMTool Version 3.5 - C:\ProgramData\Us Digita\COMToo\COMToolxml

File  Refresh Ports  Help

Product Communication Settings
Serial Port Product Baud Rate Parity Data Bits Stop Bit Hand Shaking Data Format Byte Order

After the appropriate COM port settings have been set, click on the Connect button.
If the selected COM port is successfully opened, then connection button will say
“Disconnect” and the connection settings will be disabled.

® COMTool Version 3.5 - C:\ProgramData\US Digital\COMTooh\COMToolxml

File  Refresh Ports Help

Product Communication Settings

Serial Port Product Baud Rate Parity Data Bits Stop Bit Hand Shaking Data Format Byte Order
Ccom3 AZ 9600 None 8 1 None HEX v | |BigEndian

If the COM port is already opened by another application, then the following message
will be displayed. Only one application can have the COM port open at a time.

Failed to open COM port COM3

| Access to the port 'COM3' is denied.

. W= Us Digital ® 1400 NE 136" Avenue e Vancouver, Washington e 98684 e USA e
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Transmit
@ Hex O ASCII j Sent K] [] Replace ASCIl NewLine Character (hex)
[] Clear Receive Before Sending Data
L] Auto Transmt With Delay ims) 100 * [ Append a new line to the Receive input textbox.
[ Append Temination Characters l:l Click the Send button to transmit selected data or all data if nothing is selected.
. Press Enter+Shift to execute the Send command.

[ Calculate and Append Validation Code ™| Press Enter+Ctd to transmit the active line.
[ Transmit Single Line On Enter Click the transmit Single Line On Enter to transmit each line as it is entered.

Enter bytes to be transmitted. Separate bytes with a space.

Receive _’] Received 3

1F 8543

Highlight bytes to translate from hex to Integer. Bytes Delimiter  Format = =
Configure format in which selected bytes are copied to the clipboard. |4 v | |Space ~| |Hex | | 1B _1 H

Calculated Checksum and Byte Conversion Format

2's Complement E1 G Highlighted Hex to Signed k)|
XORd 1 [ Convett | |
Modbus CRC16 FEss  |fed Signeﬂ;ﬂ F|
Endian | BigEndian w Display Format | Signed w

Selecting data as Hex or ASCII
Select either Hex or ASCII format. The COMTool provides the ability to send and
receive data as either Hex or ASCII characters. Selecting a predefined product

automatically selects the appropriate data format. Most of the US Digital products use
Hex formatted commands.

Calculating 2’s complement, XOR'd, or Modbus CRC16 value

To ensure data integrity, some devices require that commands include a checksum
especially when performing a write command or changing a device’s configuration. By
selecting the bytes to be transmitted, the COMTool automatically calculates three
different types of checksum values: 2’s complement, XOR’d, or Modbus CRC16.

. Wmmm== ys Digital ® 1400 NE 136" Avenue ¢ Vancouver, Washington e 98684 e USA e
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To append the checksum value to the end of the command, click on the add button
next to the desired value. The checksum fields and the Hex to Integer field will display
“na” when no data is highlighted in the Transmit or Receive field, otherwise the
appropriate checksum and Hex to Integer value will be calculated. The Hex to Integer
field will only have a valid value if four or less bytes are selected.

Calculated Checksum and Byte Conversion Format

2's Complement na Hex to Integer na
XOR'd na Convert 1025
Decimal to

Modbus CRC16 na Hex | 00 00 04 01

To determine the hexadecimal value for a decimal number, enter the decimal number
into the Convert Decimal to Hex field. The Hex value will automatically update as the
decimal value is entered. To append the converted decimal to hex value to the end of

the command, click on the add button.

Big-Endian vs. Little-Endian

For most devices, the Endian value is set to Big-Endian where the first byte is most
significant and the last byte is least significant.

Example: Decimal 123456 in Big-Endian is hex value 00 01 E2 40 and in Little-Endian is
40 E2 01 00.

Entering a Command

The data can be entered manually or by selecting a command from the Commands list
view. Double-clicking the command in the Commands list view will automatically copy
the command to the transmit text box and send the command to the device. If sending
hex commands, separate each hex byte with a space.

Every character or byte sent is accumulated and displayed in the Sent count label.
Every character or byte received is accumulated and displayed in the Received count
label.

. Wmmm== ys Digital ® 1400 NE 136" Avenue ¢ Vancouver, Washington e 98684 e USA e
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Transmitting Data

]
Click on the :bl send button to transmit the value in the transmit text box to the
device. Double-clicking a command in the Commands list view will place the command
in the Transmit text box and automatically send the command to the device. The
response from the device will appear in the Receive area text box. Each command
response will be appended to the end of the previously received data.

To continuously transmit the same command to the device, check the Auto Transmit
checkbox and then click the send button. Click the Auto Clear Received check box to
clear the Received textbox prior to sending the next command.

To translate a specific hex value returned from the device to a different format, select a
Display Format and highlight the hex value to translate. The “Highlighted Hex to
[Display Format]” field will automatically be updated to reflect the converted value.

Calculated Checksum and Byte Conversion Format

2's Complement 79 Q Highlighted Hex to Unsigned G4651
XOR'd 7 + Convert | |
Modbus CRC16 w07 |k ““*‘g“eﬂij +|
Endian | BigEndian e Display Format | Unsigned ~

Signed
Double
Clear Transmit or Receive Text Boxes

To clear the Transmit or Receive area text boxes, click the clear button within the
respective area.

Copy Selected Received bytes to Clipboard

There are a couple options when it comes to copying the bytes received from the device
to the clipboard. The default format used to copy the received data to the Windows
clipboard is one byte at a time separated by a space and left in the hex format.

Highlight bytes to translate from hex to Integer. Bytes Delimiter  Format s e
Configure format in which selected bytes are copied to the clipboard. | 4 v | |Space | |Hex w| | B j H

. Wmmm== ys Digital ® 1400 NE 136" Avenue ¢ Vancouver, Washington e 98684 e USA e
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Specify the number of bytes to be grouped together. The possible options
available in the Bytes drop down list are 1, 2, and 4.

Specify the delimiter to be used to separate the evaluated groupings. The
possible options available in the Delimiter dropdown list are Space, Comma, Tab,

and CR-LF.
Specify the output format. The possible Format values are Hex and Integer.

Highlight the data received that is to be copied to the clipboard.

Highlight the data received using the mouse cursor and click the copy to clipboard
button. If the received data looks like the following, then the table below shows
examples for the clipboard content format.

00 01 02 03 04 05 06 07 08 09 OA 0B OC 0D OE OF

]

Bytes | Delimiter | Format | Clipboard Contents
1 Space Hex 00 01 02 03 04 05 06 07 08 09 OA 0B OC 0D OE OF
2 Space Hex 0001 0203 0405 0607 0809 OAOB 0COD OEOF
4 Space Hex 00010203 04050607 08090A0B 0OCODOEOF
2 Comma | Hex 0001,0203,0405,0607,0809,0A0B,0C0OD,0EQF
2 Comma | Integer |1,515,1029,1543,2057,2571,3085,3599
4 Comma | Integer |66051,67438087,134810123,202182159
4 CR-LF Integer | 66051

67438087

134810123

202182159
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DCD CTS DSR  DTR  RTS Break

@ © @ © O @

COM I/0 Status Indicators

RS-232 device may be classified as Data Terminal Equipment (DTE) or Data
communication Equipment (DCE). The COM I/O Status indicators represent the status
of some of the primary communication lines and will be greyed out when the COM port
is closed otherwise they are red or green.

The DCD indicator stands for Data Carrier Detect and is green when holding and red
when not holding.

The CTS indicator stands for Clear to Send and is green when the data communication
equipment is ready to accept data and the line is high and the indicator red when it is
low and not ready to receive data.

The DSR indicator stands for Data Set Ready and is green when the data
communication equipment is ready to receive commands or data and is red when not
ready.

The DTR indicator stands for Data Terminal Ready and is green when the presence of
DTE to DCE is detected and red when it is not connected.

The RTS indicator stand for Request to Send and is green when the DTE request the
DCE to prepare to receive data and red when no request is present.

The Break indicator stand for the Break state of the COM port. The indicator is green
when the COM port is in an invalid state or an attempt to set the state of the COM port
failed. The indicator is red when there are no issues.

. Wmmm== ys Digital ® 1400 NE 136" Avenue ¢ Vancouver, Washington e 98684 e USA e
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_Commands | Seripts
Description Data
>
A2 Read Senal Number FF 3
A2 Read Factory Info FF 8
A2 Read Resolution FF9
A2 Set Ongin FF 1
A2 Read Mode FFB
®

Commands Tab

The Commands tab on the right half of the COMTool application is used to list a
predefined set of device commands that are stored in configuration file. Each command
contains a Description and Command field. The Description field typically identifies the
device and what the command does. The Command field contains the ASCII text or
hex bytes that can be sent to a device. When the COMTool application is first launched,
if no ComTool.xml file exists, one will be created with a few default entries for common
products. The typical path is C:\ProgramData\US DigitaN\COMTool\COMTool.xml

To specify the location of the command database file, click the File Menu, choosing the
“Open” option. To save the device commands, click the File Menu and select “Save”. To
save the commands to a new file, click the File Menu and Select “Save As...".

e The XML file contains commands for multiple device types. Only the commands
saved to the currently selected Product will be available.

e To add a command, enter the command description, press tab, enter the
command text, and then press Enter key. The command will be saved to the
database using the selected Product.

e To delete a command, click on the desired command row selector and then
press the Delete key. Alternatively, you can right click on a row selector and
select “Delete” from the context menu.

Local: 360-260-2468 e Toll-free: 800-736-0194 e Support: 360-397-9999 e Fax: 360-260-2469
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Commands Scripis
Script File |C:\ProgramData\US Digital\US Digital COMT ool\A2S cript bt | 3{ H i‘g
Add Edit Delete Check All Uncheck All Move Up Move Down
Description Command Expected Reply Pause (ms) Count Reply Status  Completed
Set origin F201 F201F3 100 3 F201F3 Passed 3
Read back position 22 220000 00 100 1 22000000 Passed 1
[MiSet mode (size=1) F20D08 F20D08F7 100 1 F20D08F7 Passed 1
Scripts Tab

The Scripts tab on the right half of the COMTool application is also used to read, edit,
delete, execute, and save commands. The check boxes in front of each command listed
allows multiple commands to be selected and executed in a sequence. The list view
provides additional status information for each command executed.

The commands can be read from a tab delimited file by clicking on the open button and
saved to a file by clicking on the save button.

Each command has the following fields: Description, Command, Expected Reply,
Pause, Count, Reply, Status, and Completed.

Description

Field Name Comment

Description Identifies the device and what the command does.

Command Contains the ASCII text or hex bytes that can be sent to a device.

Expected Reply Contains the ASCII text or hex bytes that are compared with the
response from the device.

Pause (ms) Identifies the number of milliseconds to wait before attempting to
read the command reply.

Count Identifies the number of times to send the command.

Reply Contains the last command received.

Status Displays “Unknown” until a command is sent. Displays “Passed”
or “Failed” when a command is sent and a reply is received and
compared with the expected reply.

Completed Contains the number of times the specified command was
successfully sent and the reply match the Expected Reply.
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Adding a New Script Command
To add a new script command, click on the Add button. The Add Script form will appear
allowing the user to enter or update the script command fields.

Enter a description for the command being added in the Description field. The
Command and Expected Reply fields are automatically filled in with the contents of the
Transmit and Received fields.

If the command being entered is something like the A2 Read Position command where
the first byte is always the same and the last two bytes can vary depending on the
encoder position, then the Expected Reply can be modified to match the expected
format. The A2 Read Position will reply with a “1F xx xx” value, where the “xx xx”
pattern represents the position returned. The following regular expression may be used
to match the pattern: "1F [A-F0-9]{2} [A-F0-9{2}$

The “V" indicates the start of a string.

The open and closing brackets “[...]" look for an explicit set of characters to match.
The open and closing braces “{...}" look an explicit number of times the previous
qualifier is to be matched.

The “$” indicates the end of a string.

To test the regular expression, enter a sample reply in the Test Reply field. If the match
is successful, then the Test Reply Matches Expected Reply field will display “True”
otherwise “False”. The Expected Reply and the Test Reply are constantly evaluated as
characters are typed into these fields.

To copy and paste the example regular expression in the Expected Reply textbox, click
on the Copy + Paste button.

To see more examples on how to use regular expressions, click on the More Help
button.

Enter the number of milliseconds to wait before reading the reply in the Pause Delay
(ms) field.

Enter the number of times the command is to be executed in the Count Field.
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Click OK to accept the changes and add the command to the list view, otherwise click
Cancel to ignore the changes.

% Add Script Command

Descnption

Command
1F

Expected Reply (Uses Literal or Regular Expression)
1F 00 00

Example regular expressions:

Pattem: "“2F 00 [afA-FO-9){2)s[afA-FO-91Z}s

2F 00 03 E8 - Matches Copy + Paste
2F 00 01 23 45 - Mot Matched, remove $to allow match.

Mare Help
Use ™ to match start of a string.
Ise %to match end of a string.
Test Reply Test Reply Matches Expected Reply
Pause Delay (ms) 100 = Count |1 = QK Cancel

Ready

Editing a Script Command
To edit a script command, select the command row and then click the Edit button. The
Edit Script Command dialog will appear containing the same fields and behavior as the
Add Script Command dialog.

Deleting a Script Command
To delete a command, select a command row and then click the Delete button.

Reorder Command Sequence

To change the sequence commands are listed and executed, click on either the Move
Up or Move Down button.
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Selecting Commands to Execute
To check all commands, click on the Check All button. To uncheck all commands, click
on the Uncheck All button.

Commands Scripts

Script File |C:HPr0gramDataRUS Digital\JS Digital COMTool\A2Script et

Add | Edit Delete Check All Uncheck All Move Up  Move Down

Executing a Scripts Command
To execute a script command, ensure that the device is connected and at least one
script command is selected and that a Script File is provided then click the run script

f "‘h
command ‘Ll[?} button. The script file is used to identify the log file that is written to
when commands are executed. The results of each executed command are written to
the log file. The log file name is the same as the script file except the file extension is
renamed to .log.

When the script command button is pressed, the status and completed fields are reset
for each command that is checked for execution. As each command is executed, it is
copied to the Transmit field, the Receive field is cleared, the command is sent, and the
process then waits the Pause (in milliseconds) time before comparing the returned
results with the Expected Reply. If the comparison matches, then the Status field is
updated with “Passed” and the Completed field value is incremented by 1. If the
comparison does not match, then the Status field is updated with “Failed” and the next
selected command will be executed. The same command can be executed multiple
times, as long as the result from each comparison matches the Expected Reply.
Completed count shows the number of times the command was successfully executed.

The reply and comparison result of each executed command are written to a log file.
Sample script log file:

8/16/2012 10:19:49 AM Sent = F2 01Received = F2 01 F3 Passed = True Completed=1
8/16/2012 10:19:49 AM Sent = 22 Received = 22 00 00 00 Passed = True Completed=1
8/16/2012 10:19:50 AM Sent=F20D 08 Received =F2 0D 08 F7 Passed = True Completed=1
8/16/2012 10:19:50 AM Sent = 1FReceived = 1F 00 00 Passed = True Completed= 1
8/16/2012 10:19:50 AM Sent = 1FReceived = 1F 00 00 Passed = True Completed= 2
8/16/2012 10:19:50 AM Sent = 1FReceived = 1F 00 00 Passed = True Completed= 3

Local: 360-260-2468 e Toll-free: 800-736-0194 e Support: 360-397-9999 e Fax: 360-260-2469
Email: info@usdigital.com e Website: www.usdigital.com

DIGITAL 19 of 20

US . mmm—= s Digital * 1400 NE 136" Avenue e Vancouver, Washington e 98684 e USA e
—



http://www.usdigital.com/

COMTool User Guide

Version 2.0

03/23/2023
8/16/2012 10:19:50 AM Sent = 1F Received = 1F 00 00 Passed = True Completed= 4
8/16/2012 10:19:50 AM Sent = 1F Received = 1F 00 00 Passed = True Completed=5

Importing Access Database Files (.mdb)

Version 3.5 of the COMTool introduces an XML format for saving Products, Commands, and Mapped
Fields. To help support older formats, the 3.5 version has an “Import” option that will convert these older
.mdb files into the new XML format. This option can be found by going to the File menu and clicking
“Import and Convert MDB”. The Access Database MDB file can then be selected from the open file dialog
box. The COMTool software will go through the database and import the existing products and
commands so they can be saved into the new XML format.

If an error like below occurs, the Microsoft Access Database Engine 2010 Redistributable will need to be
installed from the following link in order to successfully import the database:
https://www.microsoft.com/en-us/download/details.aspx?id=13255

Getting Data

Error getting data: The "Microsoft. ACE.OLEDE.12.0° provider is not
registered on the local machine,

A second message with a “Help” button will appear that will take you to the webpage to download the
Microsoft Access Database Engine.

Error Importing Database

Please download the Access Database Engine to properly
import MDE file, Click the 'Help’ button to navigate to the
download page.

ox | [Hew
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